Лабораторная работа

Использование каскадных таблиц стилей
Так что это такое - СSS? Cascading Style Sheets (Таблицы Каскадных Стилей) - это язык, содержащий набор свойств для описания внешнего вида любых HTML документов. С его помощью дизайнер имеет полный контроль над стилем и расположением каждого элемента web-страницы, что проще и гораздо функциональнее использования обычного набора HTML тегов.

1. Использование селекторов. Все объявления CSS (официально они называются «селекторы») записываются в фигурных скобках: ТЕГ {характеристика:величина; характеристика:величина;…; характеристика:величина}. Для включения стилей в документ используется тег <STYLE> …</STYLE>, расположенный внутри тега <HEAD>. 

Например: <STYLE> H1 {color:red} </STYLE>, теперь в документе все заголовки первого уровня будут красного цвета.
	Примеры:
	


Например, эта небольшая CSS (таблица стилей), находящаяся в файле "special.css", устанавливает цвет текста параграфа в зелёный и окружает его сплошной красной рамкой:
P.special {

color : green;

border: solid red;
}
Авторы могу подключить эту таблицу стилей к основному документу HTML с помощью элемента LINK:
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//RU"
   "http://www.w3.org/TR/html4/strict.dtd">

<HTML>
  <HEAD>
    <LINK href="special.css" rel="stylesheet" type="text/css">
  </HEAD>
  <BODY>
    <P class="special">Текст в этом параграфе должен быть зелёного цвета.
  </BODY>

</HTML>
Задание:
1. Используя программу Блокнот, создать новый документ, в котором заголовком первого уровня написать «ЧГУ им. И.Н.Ульянова», заголовком второго уровня «Факультет УиЭ», заголовком третьего уровня «Специальность – Мат.обеспечение и админ-ие инфрм. систем», Группа-(название).

2. Добавить в документ абзац «Добрый день».

3. Добавить в документ абзац «Мы рады Вас приветствовать на официальном сайте Группы (название). Здесь Вы найдете интересующую Вас информацию об истории факультета, его сотрудниках и студентах. Также Вы встретите детальные сведения о преподаваемых дисциплинах».

4. Используя таблицу стилей, изменить цвет заголовков первого уровня на серый, а заголовков второго уровня на черный.
2. Использование классов. Класс может быть определен либо как свойство, либо как дополнение к уже существующему определению. Классы описываются между открывающимся и закрывающимся тегами <STYLE> следующим образом: 

.имя_класса {характеристика:величина; характеристика:величина;…; характеристика:величина}. 
Примечание: обратите внимание на точку перед именем класса, имя класса – любая последовательность символов на английском языке. Теперь мы можем использовать данный класс. Для этого мы можем использовать либо известные нам теги, например, <p class=имя_класса> (теперь точка перед именем класса не ставится), либо использовать новый тег, который называется <DIV>. Все, что находится между открывающимся и закрывающимся тегами <DIV>, воспринимается как один объект. При использовании вместе с атрибутом CLASS вы можете задавать параметры текста только этой части документа, например: <div class=имя_класса>здесь находится часть документа HTML</div>.
Задание:
1. Описать класс, который задает цвет текста maroon.

2. Применить этот класс для всех параграфов.
1. Свойства каскадных таблиц стилей.
1. Свойства Font
1. font-family – определяет используемый элементом шрифт. Возможные значения: [1] любой шрифт. Если указать URL, то шрифт автоматически установится на компьютер пользователя. ПРИМЕР: font-family:Arial Black URL('arialblack.ttf').
2. font-style – определяет стиль элемента (курсивный или обычный). Возможные значения: [1] normal - без изменений, [2] italic – курсив. ПРИМЕР: font-style:italic.
3. font-variant – варианты отображения шрифта. Возможные значения: [1] normal - без изменений, [2] small-caps - заменяет все строчные буквы на прописные. ПРИМЕР: font-variant:small-caps.
4. font-weight – выделение (жирность) элемента. Возможные значения: [1] normal - без изменений, [2] bold – жирный, [3] bolder - очень жирный (в MSIE не отличается от bold), [4] lighter - тонкий (не отличается от normal), [5] любое значение от 100 до 900. ПРИМЕР: font-weight:bold.
5. font-size – размер шрифта. Возможные значения: [1] (+)размер (увеличение размера шрифта относительно текущего на заданную величину), [2] xx-small, x-small, small, medium, large, x-large, xx-large - любое из этих значений, [3] smaller, larger - любое из этих значений. ПРИМЕР: font-size:30pt.
6. font – обобщает вышеперечисленные свойства. Возможные значения: [1] font-family, [2] font-style, [3] font-variant, [4] font-weight, [5] font-size. ПРИМЕР: font: italic bolder Arial 12pt.
2. Свойства Text
1. text-decoration – "украшение" текста. Возможные значения: [1] none – нет, [2] underline – подчеркнутый, [3] overline - надчеркнутый, [4] line-through – перечеркнутый. ПРИМЕР: text-decoration:line-through.
2. letter-spacing – расстояние между буквами. Возможные значения: [1] длина (+), [2] normal - без изменений. ПРИМЕР: letter-spacing:100.
3. vertical-align – позиционирование элементов по отношению к другим элементам стоящих в одном ряду. Возможные значения: [1] baseline, [2] sub, [3] super, [4] top-text, [5] top, [6] middle, [7] bottom, [8] bottom-text, [9] процент. ПРИМЕР: vertical-align:top-text.
4. text-transform – изменение текста. Возможные значения: [1] none – нет, [2] Capitalize - каждое слово начинается с большой буквы, [3] UPPERCASE - каждая буква текста становится заглавной, [4] lowercase - каждая буква текста становится строчной. ПРИМЕР: text-transform:Capitalize.
5. text-align – положение текста. Возможные значения: [1] left - текст слева, [2] right - текст справа, [3] center - текст по центру, [3] justify - текст "растянут". ПРИМЕР: text-align:right.
6. text-indent – отступ (работает только с block-level элементами). Возможные значения: [1] длина (+), [2] процент (+). ПРИМЕР: text-indent:30 em.
7. line-height – отступ сверху. Возможные значения: [1] normal - без изменений, [2] длина (+), [3] процент. ПРИМЕР: line-height:100%.
3. Свойства Color и Background
1. color – цвет. Возможные значения: [1] цвет (+).ПРИМЕР: color:#f00000.
2. background-color – цвет фона элемента. Возможные значения: [1] цвет (+). ПРИМЕР: background-color:#f00000
3. background-image – фоновое изображение. Возможные значения: [1] none – нет, [2] URL (+). ПРИМЕР: background-image:URL(cool.gif).
4. background-repeat – повторения фонового изображения. Возможные значения: [1] repeat - размножает фоновое изображение во всех направлениях, [2] repeat-x - размножает фоновое изображение горизонтально, [3] repeat-y - размножает фоновое изображение вертикально, [4] no-repeat - не повторяющиеся изображение. ПРИМЕР: background-repeat:no-repeat.
5. background-attachment – возможность прокрутки фонового изображения. Возможные значения: [1] scroll - фоновое изображение скроллируется вместе с содержанием документа, [2] fixed - не скроллируется. Фиксируется в одном месте. ПРИМЕР: background-attachment:fixed.
6. background-position – положение фонового изображения (работает с background-repeat равным repeat-x, repeat-y или no-repeat). Возможные значения: [1] процент от ширины + процент от высоты (+), [2] top, middle, bottom - одно из значений, [3] left, center, right - одно из значений, [4] расстояние от левого края + расстояние от вершины. ПРИМЕР: background-position:50%0%.
7. background – обобщает вышеперечисленные свойства. Возможные значения: [1] background-color, [2] background-image, [3] backgroun-position, [4] background-attachment, [5] background-repeat. ПРИМЕР: background:no-repeat black fixed 50%0%.
4. Свойства Box
1. margin-top – определяет отступ сверху. Возможные значения: [1] длина (+), [2] процент (+), [3] auto – автоматически. ПРИМЕР: margin-top:100.
2. margin-right – определяет отступ справа. Возможные значения: [1] длина (+), [2] процент (+), [3] auto – автоматически. ПРИМЕР: margin-right:100%.
3. margin-bottom – определяет отступ снизу. Возможные значения: [1] длина (+), [2] процент (+), [3] auto – автоматически. ПРИМЕР: margin-bottom:100em.
4. margin-left – определяет отступ слева. Возможные значения: [1] длина (+), [2] процент (+), [3] auto – автоматически. ПРИМЕР: margin-left:100pt.
5. margin – обобщает все вышеперечисленные свойства. Возможные значения: [1] margin-top, [2] margin-right, [3] margin-left, [4] margin-bottom. ПРИМЕР: margin:100pt 100 100 100.
6. padding-top – отступ от верхнего border. Возможные значения: [1] длина (+), [2] процент (+).ПРИМЕР: padding-top:100pt.
7. padding-right – отступ от правого border. Возможные значения: [1] длина (+), [2] процент (+).ПРИМЕР: padding-right:100%.
8. padding-bottom – отступ от нижнего border. Возможные значения: [1] длина (+), [2] процент (+).ПРИМЕР: padding-bottom:100em.
9. padding-left – отступ от левого border. Возможные значения: [1] длина (+), [2] процент (+).ПРИМЕР: padding-top:100.
10. padding – обобщает вышеперечисленные свойства. Можно задать несколько значений одновременно (до четырех) для разных сторон. Если установлено одно значение - задается единый отступ для всех сторон, если два - то задаются различные отступы для прилежащих сторон, а если четыре - то задаются индивидуальные отступы для всех сторон. Возможные значения: [1] padding-top, [2] padding-right, [3] padding-left, [4] padding-bottom. ПРИМЕР: padding:100px.
11. border-top-width – толщина верхнего border. Возможные значения: [1] длина (+), [2] thin, medium или thick. ПРИМЕР: border-top-width:100pt.
12. border-right-width – толщина правого border. Возможные значения: [1] длина (+), [2] thin, medium или thick. ПРИМЕР: border-right-width:thick.
13. border-bottom-width – толщина нижнего border. Возможные значения: [1] длина (+), [2] thin, medium или thick. ПРИМЕР: border-bottom-width:100em.
14. border-left-width – толщина левого border. Возможные значения: [1] длина (+), [2] thin, medium или thick. ПРИМЕР: border-left-width:medium.
15. border-width – толщина border. Можно задать несколько значений одновременно (до четырех) для разных border. Если установлено одно значение - задается единая толщина для всех сторон, если два - то задаются различная толщина для прилежащих сторон, а если четыре - то задаются индивидуальная толщина для всех сторон. Возможные значения: [1] border-top-width, [2] border-right-width, [3] border-left-width, [4] border-bottom-width. ПРИМЕР: border-width: 15pt.
16. border-color – цвет border. Возможные значения: [1] цвет (+). ПРИМЕР: border-color:green.
17. border-style – стиль border. Можно задать несколько значений одновременно (до четырех) для разных border. Если установлено одно значение - задается единый стиль для всех сторон, если два - то задаются различные стили для прилежащих сторон, а если четыре - то задаются индивидуальные стили для всех сторон. Возможные значения: [1] none, [2] dotted, dashed, solid, double, groove, ridge, inset, outset. ПРИМЕР: border-style: dotted groove.
18. border-top – обобщает вышеперечисленные свойства для верхнего border. Возможные значения: [1] border-top-width, [2] border-style, [3] border-color. ПРИМЕР: border-top: 100em red groove.
19. border-right – обобщает вышеперечисленные свойства для правого border. Возможные значения: [1] border-right-width, [2] border-style, [3] border-color. ПРИМЕР: border-right: 5pt magenta solid.
20. border-left – обобщает вышеперечисленные свойства для левого border. Возможные значения: [1] border-left-width, [2] border-style, [3] border-color. ПРИМЕР: border-left: 15pc coral inset.
21. border-bottom – обобщает вышеперечисленные свойства для нижнего border. Возможные значения: [1] border-bottom-width, [2] border-style, [3] border-color. ПРИМЕР: border-bottom: 30 orange outset.
22. border – обобщает вышеперечисленные свойства. Возможные значения: [1] border-width, [2] border-style, [3] border-color. ПРИМЕР: border: thick black double.
23. width – ширина элемента. Возможные значения: [1] длина (+), [2] процент (+). ПРИМЕР: width:10%.
24. height – высота элемента. Возможные значения: [1] длина (+), [2] процент (+). ПРИМЕР: height:100pt.
25. float – расположение элемента. Возможные значения: [1] left – слева, [2] right – справа, [3] none - по умолчанию. ПРИМЕР: float:right.
26. clear – расположение других элементов вокруг данного. Возможные значения: [1] left – слева, [2] right – справа, [3] both - с двух сторон, [4] none - по умолчанию. ПРИМЕР: clear:both.
Задание: 

1. Скопировать последний абзац 8 раз.

2. Для первого абзаца создать следующий стиль: шрифт Arial Black, начертание – курсив и жирный, заменить все строчные буквы на прописные, размер шрифта – medium.

3. Используя свойство font, создать следующий стиль: шрифт Elephant, размер шрифта – 50. Применить данный шрифт для второго абзаца.

4. Для третьего абзаца создать следующий стиль: текст подчеркнутый, расстояние между букв – 50, каждое слово начинается с большой буквы, положение текста – по центру, отступ – 30, отступ сверху – 100 единиц.

5. Для четвертого абзаца создать следующий стиль: текст надчеркнутый, расстояние между букв – 50, каждая буква текста становится заглавной, текст «растянут», отступ – 100, отступ сверху – 500%.

6. Для пятого абзаца создать следующий стиль: цвет – синий, цвет фона – серый.

7. Для шестого абзаца создать следующий стиль: установить фоновое изображение, размножить фоновое изображение горизонтально.

8. Для седьмого абзаца создать следующий стиль: отступы сверху, снизу, справа, слева – 100.

9. Для восьмого абзаца создать следующий стиль: цвет рамки (border) –зеленый, стиль рамки – пунктир (dashed),  толщина верхней рамки – 10, толщина левой рамки – 15, толщина правой  рамки – 15, толщина нижней рамки – 10, отступы от всех рамок – 10, ширина элемента – 50%, высота элемента – 20%, расположение элемента – справа.

10. Скопировать абзац еще 5 раз. Для каждого абзаца создать свой стиль, используя свойства шрифта, текста, цвета, фона и рамок

11. Применить данные стили для частей документа, используя тег <div>.
3. Новые параметры стиля. 

1. Свойство left – используется для задания в пикселях расстояния от левого края окна (или экрана), на котором находится элемент.

2. Свойство top – используется для задания в пикселях расстояния от верхнего края окна (или экрана), на котором находится элемент.

3. Свойство z-index – добавляет новое измерение (или, если точнее, ряд слоев) на страницу. Максимум, что может сделать введение этого свойства,– это указать, в каком порядке элементы будут перекрывать друг друга. Элемент с более высоким z-индексом будет появляться над элементом с более низким.

4. Свойство position – позволяет ставить элементы в определенные позиции внутри окна браузера в сочетании со свойствами left и top.

1. absolute – означает, что заданные свойства left и top поставят элемент в место с координатами x и y относительно левого верхнего угла страницы;

2. relative – означает, что элемент будет поставлен в соответствие с тем, в каком месте исходного текста он находится;

3. static – означает, что элемент будет поставлен в некоторое положение относительно фона, но не будет двигаться при прокручивании страницы;

5. Свойство overflow – используется для определения того, что случится, если ширина или высота элемента внутри фрагмента выйдут за пределы области последнего. Это свойство может иметь три значения:

1. none (ничего) – означает, что если элемент выйдет за пределы своего фрагмента, то он все равно будет изображен (например, часть текста, для которой не хватило место в своей полосе, «вылезет» за ее пределы);

2. clip – означает, что выступающие части элемента будут обрезаны;

3. scroll – означает, что будет использован механизм прокрутки.

6. Свойство visibility – определяет, будет ли элемент виден на странице. Это свойство может иметь два значения:

1. visible – элемент виден;

2. hidden – элемент на виден.
1. Задания: 

1. Создание простого трехмерного эффекта для тескта:

1. Создать новый документ (назвать по своему усмотрению), в котором расположить три абзаца, состоящих из одного слова «Привет».

2. Описать класс: позиционирование – абсолютное, расстояние от левого и верхнего края – 100, z-index – 1, цвет текста – красный, размер текста – 100. Применить данный класс для первого абзаца.

3. Описать класс: позиционирование – абсолютное, расстояние от левого и верхнего края – 105, z-index – 2, цвет текста – желтый, размер текста – 100. Применить данный класс для второго абзаца.

4. Описать класс: позиционирование – абсолютное, расстояние от левого и верхнего края – 110, z-index – 3, цвет текста – зеленый, размер текста – 100. Применить данный класс для третьего абзаца.

5. Сохранить документ и просмотреть в браузере.
2. Создать таблицу, приведенную на рисунке 5.
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4. Выполнение: 

5. Для  создания  таблиц  удобнее  пользоваться  визуальными возможностями редактирования HTML-документов в Dreamweaver. 

6. а)  переключите web-редактор в режим визуального редактирования web-страницы; 

7. б)  добавьте несколько пустых строк после исторической справки; 

8. в)  используя  пункты  главного  меню  программы  Insert ► Table, откройте диалоговое окно вставки таблицы. Вид этого диалогового окна приведен на рисунке 5; 

9.  г)  установите  значение  параметра  Rows  равным 5, параметра Columns равным 7, а значение параметра Table width равным 350 и нажмите кнопку Ok;

10. [image: image2.png]



11. д)  курсором мыши выделите ячейки таблицы; 

12. е)  на панели свойств Properties установите значение параметра H равным 50, изменив высоту строк таблицы; 

13. ж) заполните  ячейки  таблицы  числами  дней  недели  текущего месяца. 

14. 8) Добавить в таблицу подписи дней недели. 

15. Выполнение: 

16. а)  щелкните правой кнопкой мыши по ячейке первой строки; 

17.  б)   в  появившемся  контекстном  меню  последовательно  выберите пункты Table ► Insert Row; 

18. в)   в новой строке таблицы поместите сокращенные названия дней недели. 

19. 9) Изменить выравнивание текста в ячейках. 

20. Выполнение: 

21. а)  выделите мышью ячейки первой строки; 

22. б)  на  панели  Properties  измените  свойство  Horz  на  Center,  а свойство Vert на Middle (см. рисунок 7);
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24. в)  аналогичным  образом  измените  выравнивание  чисел  месяца в таблице, расположив их в правом верхнем углу ячеек. 

25. 10) Изменить цвет фона ячеек и цвет границ таблицы. 

26. Выполнение: 

27. а)  выделите мышью ячейки с названиями дней недели; 

28. б)  измените  фоновый  цвет  ячеек  на  оранжевый.  Для  этого  на панели Properties щелкните по квадратику рядом с надписью Bg и выберите на палитре соответствующий цвет; 

29. в)  используя  предыдущий  опыт,  измените  фоновый  цвет  ячеек будних и выходных дней на голубой и зеленый соответственно, а цвет текущего дня на красный; 

30.  г)  измените  цвет  границ  таблицы.  Щелкните  по  любой  ячейке правой  кнопкой  мыши  и  в  появившемся  контекстном  меню выберите Table ► Select Table. Это приведет к выделению всей таблицы,  а  на  панели  Properties  можно  будет  редактировать глобальные  свойства  таблицы.  Свойство  Brdr color  позволяет менять цвет границ в таблице. Измените этот цвет на любой другой. 

31. 11) Завершить создание таблицы 

32. Выполнение: 

33. а)  объедените  ячейки  дней,  не  относящихся  к  текущему  месяцу. 

34. Выделите их, щелкните по ним правой кнопкой мыши и выберите пункт контекстного меню Table ► Merge Cells; 

35. б)  перейдите  в  режим  правки HTML-кода,  используя  пункты главного меню View ► Code, и посмотрите, что изменилось в коде странички; 

36. в)  выполните просмотр web-страницы в браузере. Примерный вид таблицы приведен на рисунке 8.
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